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First Steps Beginner-level tutorials 
for users dipping their toes into Linux

R
SS (Rich Site Summary or Really Simply Syndication 

depending upon whom you believe) is one of those 

technologies that could have a dramatic impact on the 

browsing habits of millions of users – if only they knew it existed. 

Basically, it’s a more effective way of using the Internet; making 

the content you’re interested in come to you rather than having to 

go out and find it, or refind it, every time you want an update. In 

this tutorial we’ll look at setting up an RSS client in both Gnome 

and KDE before turning our attention to more integrated solutions 

that will put RSS feeds into your browser or mail client – the place 

where many people feel they belong. We’ll also look at a couple of 

online solutions that can be used to manage your information on 

any network connected computer.

But first, what is RSS? Simply put, RSS is an XML data format 

that allows content producers to package up their work – blogs, 

news stories, features – in a way that can then be ‘subscribed’ to 

by readers in their web browsers, email clients or a dedicated RSS 

reader. This piece of software will then ‘poll’ the website where the 

subscription is held – well, a specific page within the site – and if 

there has been an update, the new content will be downloaded 

into the reader and will appear as unread, just like a new email 

does. The user can then click on the link to see either a summary 

of the story or the entire text. In either case, there will be a link to 

take the user through to the originating site.

As an example, we could visit the BBC’s news website, navigate 

to the Technology section (http://news.bbc.co.uk/1/hi/

Last month How to migrate all your system settings from Windows to Linux.

technology/default.stm), find the RSS icon – a small orange 

square with a broadcasting-esque symbol and subscribe to the 

feed. Every few minutes, our software will check the RSS feed 

from the Beeb (the page itself is at http://newsrss.bbc.co.uk/

rss/newsonline_uk_edition/technology/rss.xml) and if 

anything has been added, it will be downloaded to the reader. And 

so we don’t have to go to this site to check whether anything has 

been added, we’ll know through the magic of RSS. Smart.

And while we’re using text in our examples below, RSS is 

sophisticated enough to cope with other content formats 

including audio (podcasting), pictures (photocasting) and even 

video (vodcasting?!), so these instructions could be repurposed 

quite easily for a range of different tasks. 

Setting up Liferea
 As you may expect there are many RSS readers available for 

Linux and for the main desktops. On Gnome, the ‘standard’ reader 

is Liferea, an application with a clumsy name (an abbreviation for 

LInux FEed REAder), but nonetheless has a powerful and intuitive 

featureset that is equally at home on a KDE desktop. The latest 

version of Liferea is 1.4.9 and is available from http://liferea.

sourceforge.net. Source and binaries are available for a range of 

distributions and we grabbed the latest Ubuntu-specific package 

via the desktop’s Applications > Add/Remove menu. Once 

installed, the application will appear under the Internet portion of 

the Applications menu, and by default it ships with a wide 

selection of feeds from sites such as Slashdot, Groklaw and Planet 

Debian – not exactly light reading for the avid desktop user. We’ll 

get rid of those in a minute. 

The user interface is divided into three panes, a narrow one on 

the left where your feed source tree is, a large top pane to show 

the contents of the feed and a large bottom pane showing the 

 Liferea is a cool standalone Gnome RSS reader that is equally 

at home in KDE.
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content of individual stories, or more likely a summary. To show 

the feed you select it from the source tree, to show the content, 

you select from the articles list and to see the whole story you 

click the headline in the summary. Simple. And when a story has 

been clicked on it will lose its bold designation so you know it’s 

been read. 

We want to customise Liferea to reflect LXF’s tastes, so first 

we’re going to set a few folders to collect individual feeds. To do 

this, right-click anywhere within the feed source tree pane and 

select New Folder. Give this folder a name such as Television, and 

then repeat for every other category you want to define. If you 

accidentally create a folder in the wrong place it can be dragged 

and dropped to a new location within the list. Unusually, Liferea 

respects your choices and won’t try to reorder your folders on an 

alphabetical basis, so if you decide you want TV ahead of Linux, 

then you can drag and drop safe in the knowledge that things will 

be exactly the same next time you boot up the software. Now 

we’re satisfied with the list of folders we can begin adding feeds. 

Fire up Firefox and navigate to the source of your desired feed. In 

the Firefox address bar, click on the RSS icon and then click the 

drop-down menu labelled Live Bookmarks and select Choose 

Application... This will launch a standard file browser where you 

can locate the Liferea application. On our Ubuntu system it was at 

/usr/bin/liferea-add-feed. If you remember to check the Always 

Subscribe With... button, before hitting the final Subscribe button, 

you’re next subscription will automatically be added to the 

application. The software tries to be a bit clever – a BBC 

subscription was automatically added to our Television folder 

(even though it was from the technology section of the site) but a 

Guardian Technology subscription was added to the Technology 

folder. If Liferea can judge our intentions well, it could make 

managing subscriptions much easier. If, however, it dumps a feed 

into the wrong place if can just be dragged and dropped into the 

right location with no problem. 

Opening up a feed means simply opening its folder and then 

clicking the required subscription. Handily, each feed will have a 

number next to it in brackets: this indicates the number of unread 

entries in the feed. Similarly, when you close a folder you’ll get an 

aggregate number of the unread parts of each feed within the 

folder and, of course, at the top of the list is the Unread icon which 

tells you how much overall you’re missing out on – which can 

sometimes look a little overwhelming. However, if it all starts to get 

a little too much you can right-click a feed or folder and select 

Mark All as Read. 

By default Liferea will cache 100 entries from each feed and 

the rest will slowly disappear from the bottom of the feed into the 

aether. You can change this number by doing Tools > Preferences 

and then look under the Feeds tab. This is also where you can set 

the automatic refresh option for your feeds. It can be tempting to 

set everything to update every 10 minutes, but if everyone did this 

the internet would grind to a halt; instead choose to update every 

one or two hours and then, if you really do need a more (or less) 

frequent update from a specific feed you can set these individually 

by right-clicking a feed, selecting the Properties box and then 

setting the refresh rate in minutes, hours or days. 

For posterity 
While old news slipping from the bottom of your feed is usually a 

blessing, sometime you want to keep a story beyond its natural life 

– perhaps for university research or work purposes. Liferea tackles 

this problem really elegantly with a feature called New Bins. These 

are kind of virtual folders where you can drag and drop a story to 

keep for later consumption. Creating a News Bin is, once again, a 

case of right-clicking within the feed source tree pane and 

selecting the appropriate entry from the menu. Now simply right-

click on a headline, select Copy to News Bin and select the newly 
 The application attempts to add feeds to the appropriate 

folder based on its content – it’s usually pretty good.

 Set a sensible 

interval for 

getting updates 

or between us, 

we could kill the 

internet!

“Liferea handles the saving 
of your chosen stories in 
an elegant fashion.”
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created bin from the list. This story will now stay within that folder 

even if you – or time – deletes the original feed story. 

Even more powerful is the Search Folders feature – a new 

search folder can be added in the same way as a normal folder or 

news bin – which can be set to filter the contents of your feeds 

based on specific key words. So, for example, if you particularly 

interested in stem cell research, you could subscribe to a ton of 

medical or ethical news sources, set up a Smart folder to grab just 

stories that contain the phrase Stem Cell and then ignore the 

original feeds unless something that matches your criterion is 

published. This story will appear as a story within your named 

Smart Folder; stories already cached as part of a feed will also be 

added to the folder, but they will disappear as the cache gets 

cleared – unless you save them to a news bin. The system is 

capable of taking multiple arguments, so you could, for example, 

filter stories that do contain the phrase ‘Stem Cell’ but not the 

phrase ‘George W Bush’.

Finally, the application also has a standard search facility which 

provides for the searching of keywords in all feeds. Unfortunately 

it’s not possible to restrict searches to individual feeds, but you 

can’t have everything.

Liferea is a well-rounded package that can manage feeds well 

and also integrates with a selection of online services such as 

Bloglines or Google Reader (see the box, below) to provide both 

online (computer-neutral) access to your feeds as well as local 

access. To add a remote set of subscriptions to the application, 

right-click in the feeds list and, from the context sensitive menu, 

choose Subscriptions > New Source. Choose the source type 

from the three available options. The first is OPML, Planet or 

Blogroll, and if you choose this you’ll simply need to add the URL 

for the subscription to have the content arrive in your reader. The 

second and third options – Bloglines and Google Reader 

respectively – will require you to input your username and 

password for the account before the subscription can be 

downloaded to your machine. 

However, Liferea won’t be able to synchronise the read state of 

your account with either Bloglines or Reader, so if you read 

something offline, this state won’t be shown in the online version – 

and vice versa.

RSS in your browser
For many users, RSS is most at home in the web browser. This 

seems to tally with the thoughts of the Firefox developers because 

the technology is tightly integrated into the browser’s bookmarks 

system. It’s also incredibly simple to use. 

To add an RSS bookmark, navigate to a site with an active feed. 

Firefox will display an RSS icon within its address bar if a site 

actually has a feed. Click on this to be taken off to the subscription 

page. The first time you do this, Firefox will offer to save the feed 

using Live Bookmarks (which is what we want at the moment), 

but there are also a few other options, including one to set any 

external application – see above – to handle the feeds. If you’re 

happy with Live Bookmarks, click the option to ‘Always use Live 

Bookmarks to subscribe to feeds’ and then hit the Subscribe 

button. As with any bookmark you’ll have the option of setting a 

location for the bookmark, and once that’s done you can find it 

under the Bookmarks menu. A Live Bookmark will display the 

ubiquitous RSS icon, and selecting it will cause a new menu to fly 

out with the latest entries from your subscribed feed. Clicking any 

of these options will take you straight to the appropriate content.

You can, of course, do anything with these bookmarks as you 

could with any other type of bookmark. So if you go into 

Bookmarks > Organise Bookmarks... you could set up a New 

Folder, label it Feeds and then add your Live Bookmarks to that 

folder. If you then move this folder to the Bookmarks Toolbar 

folder and then, back in Firefox, select View > Toolbars > 

Bookmarks Toolbar, you’ll never be more than two clicks away 

from the latest news. 

If your needs are not extensive, Live Bookmarks will probably 

be enough to scratch your feed itch, but it’s not the only way to 

integrate feeds into the browser. It’s also possible to add an RSS 

plugin to Firefox and then view your feeds in a sidebar, which is 

great for those who have larger monitors or like viewing narrow 

No Client...

There are those who don’t believe that you 

should bother with an RSS client and just 

use one of the many tools available on the 

internet. Probably the best online RSS tool 

is Google Reader, which benefits from a 

very close relationship with other Google 

services such as Blogger, Feedburner and 

the iGoogle Personal Homepage. 

If you already use one Google service, you 

can use your username to log in to Google 

Reader at www.google.co.uk/reader. To 

add a feed to the service, you can navigate 

to the feed host, click on the RSS icon in 

the address bar and then copy (Ctrl+C) 

the URL from the address bar. In Google 

Reader, click on Add Subscription and then 

paste (Ctrl+V) the URL into the 

appropriate space. You can also hit the 

Discover link to see feeds that Big Brother, 

sorry Google, thinks you might be 

interested in, based on your search habits 

and the feeds you’ve already subscribed 

to. Like Sage, Google Reader is completely 

styled by Cascading Style Sheets, and you 

can skin the entire application using the 

Firefox plugin Stylish which is available 

from http://userstyles.org/stylish/. This 

extension, and some of the available 

styles, can give Google Reader the look 

and feel of a native Linux, Windows or Mac 

desktop application. 

Reader also integrates well with Google 

Gears, so you can download content for 

offline reading fairly easily.

 Smart Folders will ensure you only see the stories you need.

 Firefox’s subscription page allows you to choose your weapon 

(well, reader) of choice
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Next month Do exciting and interesting things with your own RSS feed.

 It’s possible to 

redesign Sage feeds 

quite easily with a 

little CSS.

need to look at Slashdot’s green overload again. These style files 

are so simple, that it’s quite easy to change colours, fonts, sized 

etc to create something completely unique – but that’s something 

for another tutorial. 

If you spend any time on the internet – especially if you find 

yourself visiting a regular series of websites – a decent RSS reader 

can make your online life so much easier. Liferea’s powerful search 

folders offers the ideal combination of serendipitous discovery 

through feeds and the ability to filter masses of information into 

easy to manage streams of relevant data. Start using it – or one of 

the other systems mentioned here – and you may find it 

impossible to go back to plain old vanilla browsing again. LXF

 Sage is currently 

the best RSS 

reader for Firefox.

websites. The pre-eminent RSS plugin for Firefox is Sage, which 

can be obtained from http://sage.mozdev.org/. It installs, as 

other plugins do, through a downloadable XPI file. If – as 

happened to us – the file doesn’t install automatically, you can do 

File > Open File in Firefox, navigate and select the XPI and then hit 

OK. You’ll need to restart the browser to fully install the plugin. 

Sage is very cool if you’ve collected lots of Live Bookmarks as it 

integrates that system automatically, which also means you won’t 

have to change your method of adding feeds to the browser.

Once the browser has restarted, do View > Sidebar > Sage to 

open the sidebar, or click the Sage icon which may appear in your 

Firefox toolbar. It will be populated with a couple of feeds and 

clicking on any of these will do two things. Firstly it will display a 

long list of stories in this lower part of the sidebar. This is the 

headline feed. Secondly, it will display a formatted feed in the main 

pane of the browser in a new tab. This latter facet can be quite 

useful, but after a period you may find it’s a bit annoying. 

Fortunately we can switch it off. In the Sage sidebar, select the 

Options drop-down from the toolbar and choose Settings... A new 

dialogue box will open up from which you can deselect Render 

Feeds in Content Area. Hit OK and now when you click on a feed in 

the top part of the side bar, you’ll only see the list of headlines and 

your content area will stay untouched. To see a summary of the 

story in the sidebar, hold your mouse over the headline and wait, a 

précis will appear in a tooltip. Click the headline to whiz off to the 

original story. 

Adding a new feed is the same as adding a Live Bookmark. 

Click the icon in Firefox’s address bar, select Live Feeds in the feed 

page, but then choose Sage Feeds as the destination. Your feed 

will now appear in the Sage sidebar ready to be viewed. By default, 

Sage will display a feed’s unread entries in bold, and read feeds will 

be shown in normal text. As we’re not necessarily interested in 

every story in a feed, this can mean that, after a short while, there 

are thousands of ‘unread’ entries on any given feed, so judicious 

use of the Mark All as Read button, which appears just above the 

feed itself, can be quite good.

Managing feeds you’ve already subscribed to within Sage 

follows the same principles as most file managers. Right-click a 

feed, for example, to see a context-sensitive menu where you can 

view the feed properties, delete or reload a feed. There are also a 

few space management tools here such as options to create new 

folders, separators and to reorder feeds.

Finally, if you prefer to read the read in the content area, but 

don’t appreciate the Sage developers’ blue theme, it’s entirely 

possible to download a variety of different styles from the project’s 

website or, if you’re feeling a little ambitious, to create your own, as 

the content area is fashioned using fairly simple CSS code. To add 

a new theme, go to http://sage.mozdev.org/styles/ and find a 

style you like. You’ll get a live preview. Then scroll down the page to 

the Source Frame, right-click and do This Frame > Save Frame As... 

and save the file to a sensible location. Now, back in the Sage 

Options, click on Use Custom Stylesheet and then browse to the 

location of the file you just saved. Next time you view a feed in the 

content area (which we switched off earlier) it will be rendered in 

the style of the stylesheet you just downloaded. And you’ll never 

Who uses RSS? 

Almost every news organisation in the 

world throws out some sort of RSS 

content. In fact, where it used to be odd to 

find a live feed on a news web page, it’s 

now extremely strange not to see one. And 

if you use one of the main blogging 

services such as Blogger, LiveJournal or 

WordPress, your musings will usually be 

made available to the reader-toting 

masses by default. Even Flickr, Facebook 

and Linux Format offer feeds. Just look out 

for the little orange icon and start reading...

“Managing feeds within 
Sage: the same principles 
as most file managers.”
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